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SmartPM’
Introduction

This manual will help you get started using the SmartPM™
software by leading you through the steps for importing a
project, analyzing that project, and navigating through the
project by discussing the following topics:

- Loading all native schedule updates for the Project

- Running a delay analysis for insights into the Project
- Review Schedule Quality index for all schedules

- Reviewing and understanding the Delay Analysis

- Reviewing and understanding the Audit Log

- General navigation of the system



Importing a New Project

In order to get started, you will need to locate available official & final
schedule updates for the Project you would like import into the SmartPM™
Software

* SmartPM™ only accepts native schedule files from Oracle Primavera
(.xer files) and Microsoft Project (.mpp files)

* Once those schedules are identified & procured, import the schedules
into SmartPM™ in from earliest data date to latest data date
> All Primavera schedules have to have a data date built in due
to Primavera rules. However, MS Project does not require a
built in data date; therefore you will be asked to identify MS
Project file's data date upon import
 If for any reason and error occurs during an import, reach out to your
SmartPM™ Client Services Manager
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From your Dashboard Select “Add New
Project” and select the type of
schedule file you will be importing. You
will then be prompted to import the
Baseline schedule for the Project

For Primavera Files

1. Select “Import Primavera
(XER)"

2. Click “Select File” and locate
the file in your computer’s
directory
Give the Project a Name
Enter the Country and Zip
Code where the Project is
located

For Microsoft Project Files

1. Follow the same steps as
above and also enter the
Data Date for the Baseline
schedule

Importing a New Project

Smartp:\ﬂ"' SmartPM Technologies Demo w

Dashboard

B (2] »)

Resources Help Admin Logout
Overview
11 1= 1
0 0 0 @ O
Projects Delayed Projects with Low Quality Projects that need new Projects on track
Schedules
0 Project Q. Search projects Add New Project

| Greate New

No schedules have been analyzed yet! Click here to watch a short tutorial on how to import and analyze yc¢

Import Excel
Import Primavera (XER)
Import Microsoft Project (MPP)

IMPORT PROJECT FROM PRIMAVERA (XER)

XERFIE | |
NAME | (Optional) |
COUNTRY United States of America v
ZIPCODE | |
Canc

IMPORT PROJECT FROM MICROSOFT
PROJECT (MPP)
MPP FILE | |
NAME [ (Optional) |
DATA DATE | | =
COUNTRY United States of America
ZIPCODE | |

Cancel
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If your Project is just starting out and the
Baseline is the only schedule you have for
the Project, you are done with the
importing process. However, if you have
Schedule Updates, you will want to add
them to the Project.

Click the “Add Schedule Update” link
Click the “Select File” button and locate
the file in your computer’s directory
If your Project is Microsoft Project
based, you will need to enter a Data
Date for the new Update

4. Click “Upload”

5. Repeat for all updates

Note: All Schedule Updates must be the
same file type. For instance, you cannot
import a Microsoft Project Schedule

Update on top of a Primavera Baseline.

You can also upload an Image of your
Project by clicking on the “Upload Project
Image” button on the left

Importing a New Project
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Apartment Tower 01 - Ph1-2 Construction Only ‘ [51 Add Schedule Update @ Delay Analysis Ll Pink Report [ﬁ_T[
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Once all your schedules are imported you
will notice that there are zeros across the
Project’s Schedule Delay section. In order to
automatically calculate these figures, you
will need to run a Delay Analysis.

The Delay Analysis feature creates a
schedule by schedule windows analysis
based on the data from the imported
project schedule updates.

1. Once all schedules have been imported
click the “Run Delay Analysis” option in
the Project Window on the SmartPM™
dashboard
You will receive an email once the delay
analysis is complete

> A delay analysis can take anywhere
from 30 seconds to 45 minutes
depending on the length and size
of the schedule
If for any reason an error occurs during
a delay analysis, reach out to your
SmartPM™ Client Services Manager

Run Delay Analysis

' SmartPM Technologies Demo

SmartPm”
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Projects with Low Quality
Schedules

1 Project
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schedules

Q. Search projects Add New Project
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SCHEDULE DELA 5 EDULE FEASIBIL
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Actual 59% A = ure s Campltin i
SmartPM SmartPM Technologies Demo w b, B @ b =
Dashboard Resources Help Admin Logout
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SmartPM
Overview
i) Dl D)
0 0 A 1
Projects Delayed Projects with Low Quality Projects that need new Projects on track
Schedules schedules

Y Apartment Tower 01 - Ph1-2 Construction Only

Aflanta, GA 30303

Data Date: Dec 19, 2018
Planned os% Y

Actual 59% A

Q  Search projects Add New Project

Add Schedule Update @ Delay Analysis Ll Pink Report ]ﬁ[
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Your Company Dashboard is your hub to
view the key metrics across all of your T h e D a S h b O a rd

Company'’s projects. From this view you

| . M” [ i B ) o

can view. SmartPM SmartPM Technologies Demo w .- oo o = LO.;Ut

An executive overview on the health & Overview @

status of all of your projects o 4 3 & d —

U p I Oa d Ed | m age Of th e P rOJ eCt Projects Delayed Projects with Low Quality Projects that need new Projects on track

Location of the Project for weather Schedules Bl

tracking purposes

Schedule Quality Grade of the latest 4 Projects Q. search projects Add Now Project

schedule which you can click on for
more information
The Data Date of the most recently

Apartment Tower 01 - Ph1-2 Construction Only Add Schedule Updaie @ Delay Analysis  |al Pink Report

Aflanta, GA 30303 9 @
o SN Data Date: Dec 19, 2018 e e Ape g
QUALITY Planned 95% 138 83 39 o o 29 19
: DAYS RS Ll 82% 2018 2018

imported Schedule and the Actual e B P o == ==
Percent complete in that schedule as
Apartment Tower 02 - Ph1-3 Construction Only Add Schedule Update O Delay Analysis  lul Pink Report

compared to the Baseline

The Schedule Delay & Recovery figures
for the Project

A look at the feasibility of the Project,
as ||Sted |n the |atest SChedU|e Update, - ‘L( I L!;dustrialm-Orig. Construction Only £ Add Schedule Update  ©® Delay Analysis  Lul Pink Report

Aflanta, GA 30303

EiidDalet Dec 19, 20;61‘ . 04 83 m 3;11 15
— A R 2019 2020

Critical Psth Future End Daie Sehedul Senaduled Forecast
Actual 40% A ey Vari Chakithe tion G n

Recovery risnce Compressicn

R ——

lanta, GA 30303

moving forward
The Pink Report creation button

SmartPM’



Click on the Schedule Quality Grade on
the dashboard or the Quality Index
button from the Gantt Chart View.

SmartPM's™ Schedule Quality Index
grade assessment is guided by the
United States Defense Contract
Management Agency’s (DCMA) 14-point
schedule assessment guideline. The
DCMA guideline was developed by the
Department of Defense to evaluate the
enormous volume of contracts and
schedules they were tasked with
managing. Essentially, it is evaluating
whether a schedule is well-built and
whether it adheres to a set of best
practices considered important to the
success and manageability of a project.
These best practices are broken down
in the attached “Schedule Quality Index
Explained” document.

Click on any value to automatically filter
for the offending activities in the Gantt
Chart view

Schedule Quality

Schedule Quality Index:

Total Activities
Milestones
Activities

Total Relationships
Finish to Start
Start to Start
Finish to Finish
Start to Finish

Missing Logic

Negative Lag

Positive Lag

Constraints

D+

266

25

237

369

275

46

48

6

92

45

1.4:1

Current Schedule Date: MARKET SQUARE 0524201¢ »

Filter: FILTER

High Float Activities 140 _
High Duration Activities 8 3%

Resource Loaded Activities 0 _
Critical Path % 32 12% |
Avg. Activity Total Float _

Schedule Compression Index N/A

-
« == [ Schedule Quality

¥ = I Index Explained
V-

Click here
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https://smartpmtech.com/wp-content/uploads/2019/02/Schedule-Quality-Index-Explained-1.pdf
https://smartpmtech.com/wp-content/uploads/2019/02/Schedule-Quality-Index-Explained-1.pdf

The numeric grade is categorized The SmartPM™ Schedule Quality Index is set to default to the DCMA 14-point guidelines.
based on the table below. Thresholds are fully customizable and can be set to your specifications.

IR 3 T T T
Total Relationships 5 >=1.25 2.5 <1.25
Finish to Start > 90% 80% - 90% -1 <=80% -2
Start to Start <=5% 5% - 10% 5 >=10% 2
Finish to Finish < =50 5% - 10% -1 >=10% -2
Start to Finish <=0% 0% - .2% -1 >= 20 -2
Missing Logic <=2.5% 2.5% - 5% -% > 5% - %
Negative Lag <=2.5% 2.5% - 5% 1.5 > 5% -3
Positive Lag <=2.5% 2.5% - 5% 1.5 > 5% -3
Constraints <=2.5% 2.5% - 5% % > 5% - %
High Float Activities <=20% 20% - 33% -1.5 >33% -2.5
(>44 days)
High Duration Activities <=2.5% 2.5% - 5% -25 > 5% -5
(>44 days)
The grade for the quality index is Sl 10% - 20% 5%-10% or -25 < 5% or >30% 5
calculated by subtracting the penalties 20% -30%
from 100 based on the individual Average Total Float 15 - 44 7515 y <75 or>= 44 5

metrics based on the Quality Index.

SmartPM’



The Schedule Delay section will let you
know the total delay, future recovery, and
end date variance from the Baseline to the
latest update on your Project S C h e d U | e D e | ay
« This metric tells you how many days of
actual critical path delay the project has SCHEDULE DELAY
suffered to date. Behind this metric is
an in depth delay analysis complete
with a delay table and schedule 1358 83 55
summary that review, analyze and/or - -
drill down on Critical Path Future End Date
The future recovery of a schedule i sty i
captures the remediation efforts that
have been put in place by the scheduler
in order to recover time from the delays
that have occurred thus far and bring
the project completion date back in
The end date variance of a schedule
captures the diversion of the current
schedule completion date from the
baseline schedule completion date

SmartPM’



The Schedule Feasibility section provides
you a window into to the health of your
Project and reliability of the plan moving

Formard Schedule Feasibility

The schedule compression captures
the amount of effort remaining in the
schedule as compared to the
baseline.

SCHEDULE FEASIBILITY

e 29 19

SmartPM's™ forecasted completion

2014 2014
date uses a proprietary Al based Sehedule Scheduled Forecast
: ; z (=3 C let
algorithm based on current progress Compression B FmEEREn

to give a realistic estimate of what the
completion date of the schedule
should be given things progress as
they have thus far. The scheduled
completion date shows the
completion date based on the current
schedule update.
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The Pink Report is an executive summary of the

project to date that empowers you with the T h e P I n k Re p O rt

information you need in order to have the
appropriate conversation with your leadership

team Or CO ntraCtOI’S. SmartP\fl SmartPM Technologies Demo v P Resoumes ng A:f“n Lo.;ur
Follow these steps to have SmartPM™ s
auto-generate an executive report for your 0 0 N 1

P rOj e Ct th at i n C | U d eS : Projects Delayed Projects with Low Quality Projects that need new

Schedules schedules

Projects on track

1. All Schedule Quality Issues

2. A Summary Progress Graphic 1 Project rogr—
3. A Copy of the Delay Table
4

All Critical Changes in the Audit Log

| Apartment Tower 01 - Ph1-2 Construction Only B Add Schedule Update _ lud Pink Report ]

Atlanta, GA 30303

Data Date: Dec 19, 2018 pr Jul
Planned 95% ¥ 1 38 83 55 29 1 9

Critical Path Futire EndDsie  Schedule Scheduled Forecast
Actual 59% A Delay Hacenary Varse on Completion

Here are the steps:

1. Click the Pink Report button on the
dashboard to activate the Pink Report
Creation menu
Select Schedule Update: Select from
which schedule update the graphic will

mmmmmmmmmm

PRINT PINK REPORT

Select Schedule Update:

be based Off Of December 19, 2018 v
Select WBS Level to Group From/To: Select WBS Level to Group From:
Select the range of WBS Levels the el i
summary bars in the summary graphic

will be generated via. Note, the Select WBS Level to Group To:
maximum selectable range is 1 level | Level 3 v]
apart | |

4. Click “Print”

. SmartPM’



From the Dashboard, click on your Project’s name to
open it up into the Gantt Chart view. This view may
look more familiar as a traditional schedule view.

In addition to viewing your schedule, you can drill
down with specific analytics, and review delays,
recoveries, and changes across the life of your
Project.

Analytics at the Project level

Analytics at the Activity level

Analytics based on an Applied Filter

The Audit Log

The Delay Table

Delay-Analysis “On” Switch (this MUST be
on to use of SmartPM’'s™ best capabilities)
Planned Bar “On” Switch

Organizational Structure “On” Switch
Filter “On" Switch
10 Quick Search

The following is a key to all that you see within the
Bar Chart section of the Gantt Chart:
Blue Fill: Period of Actual Progress
White Fill: Period of No Progress for an
Activity that should have had Progress
Green Fill: Planned Work
Red Fill: Critical Path
Green Outline: Actual Critical Path Recovery
Yellow Outline: Historical Near Critical Path
Red Outline: Historical Critical Path
“X": Day of Delay

The Gantt Chart

T Broject Mictrzs 0 MHEaad O GestBased gl iz Prsgresss.

Start uration g Pl i
0 7 3) 9446 6

Current 8/ 31,-’16 4 25/19 872
Variance o
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The Delay Table provides you an D e | ay Ta b | e

automatically generated Windows Analysis;

5 A P PROJECT METRICS ACTIVITY METRICS GROUPED METRICS AUDIT LOG DELAY TAELE
letting you know exactly what activities
FERIOD SCHEDULEAUN | SCHEDULED ENOD ENDDATE VARISHCE  CRDELAY REALZED CF HET CF DELAY DESCRIFTION OF CF DELAYS {IN PERIOD) PLANNED DELAY RECOVERY | SCHEDULE COMPRESSION
d | d d d h o= oeTE | RECOUERY AMEERINL ™ CUMHATAE IKPERIOD | CUMULATIVE INDEX
We re e aye v recove re z a n W e re yo u (] 62017 3512018 ] [i] 0 0 Defays: ]

. 0 Recoveries:
Sta n d m OVI n g fo rWa rd 1 82372017 31172019 i} (i} 15 9 6 6 4 Delays: 0 0 1.0549
« CC:1200 - Demo Site Wall @ Peachtree Rd. (7 days)
= CC.1090 - Shoring & Excavataion @ Tower Base (5 days)
Schedule Period
« CC.1090 - Shoring & Excavataion @ Tower Base
SChed u |e Ru n Date' 2 92172017 372019 -4 2 20 18 2 8 2 Delays: 6 i} 1.1053
s CS5.0310 - Drilled Fiers (Crew 1) {12 days)
2 Recoveries:
BILE s (CC.1260 - Excavate Elevaior Mat Foolings
C rltl Ca I Path D e | ay » CS.0410 - Pile Caps and Concrete Foundations
« C5.0550 - Form & Place Concrete Columns (12 days)
» CS5.0410 - Pile Caps and Concrete Foundations {11 days)
iti | h I 2 Recoveries:
N et Crltl Ca Pat De ay I = (C5.0550 - Form & Place Concrete Columns
« ©5.0310 - Drilled Piers (Crew 1)
s CS5.0410 - Pile Caps and Concrete Foundations {12 dayzs)
D e | a S/ Re C OVe r » (S5.0540 - Vertical Foundafion Walls (Perimeter, Dock, Interior) (7 days)
y y « CS.0810 - M/EF Underground (Lobby Level) (3 days)
Planned Delay Recovery -

s CC. 1170 - Balance of Site Demolition (10 days)
CS.0310 - Drilled Piers (Crew 1) {1 days)
+ ©S.0310- Drilled Piers (Crew 1)
E N d D ate Va r| ance « CC.1230- WG Storm Sewer @ Stratford Drive (8 days)
. .. 3 1082017 342019 1 2 17 4 13 2 2 Delays: 12 18 11443
Realized Critical Path Recovery
Descnp“on Of Cr|t|ca| Path 4 MASR017 | 302019 N 14 19 (] 19 a0 4 Delays: 8 2 11554
+ £S.0850 - Form & Piace Concrete Columns (7 days)
+ ©S.0810 - W/E/P Underground (Lobby Level)

. « £S50550 - Form & Place Concrete Columns
SChedU|e CompreSS|On |ﬂdeX 5 | 12132017 311572018 - 10 13 20 =7 13 2 Delays: 3 23 11047
= (50810 - M/E/P Underground (Lobby Level) (13 days)
s C5.0410 - Pile Caps and Concrete Foundations (1 days)
3 Recoveries:
« £S.0810 - WIE/P Underground (Lobhy Level)
S E E N EXT PAG E FO R D E FI N |TI O N S ° « CS5.0820 - Concrete Slab-on-Grade (Lobby Level)
* = (CS5:1022 - Form { Re-Bar { MEF [ Place - Level 2a
6 11812018 3252019 10 20 &7 3 14 47 3 Delays: 4 27 1.2297
s CS5.1032 - Form / Re-Bar / MEF | Place - Level 3a (10 days)
« (£5.1022 - Form / Re-Bar / MEP / Place - Level 2a (7 days)
« C5.0820 - Concrete Slab-on-Grade (Lobby Level) (5 days)
4 Recoveries:
« CS.0810 - MVE/P Underground (Lobby Level)
= C5.1022 - Form/ Re-Bar{ MEP / Place - Level 2a
« £S51032 - Form / Re-Bar / MEP / Place - Level 3a
= (CS.0820 - Concrete Slab-on-Grade (Lobby Level)
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Schedule Period - This is the period for review between the current schedule and the one before, obviously listed by title.
Schedule Run Date - This is the data date of the schedule that was imported during a specific period.
Schedule End Date - This is the PLANNED end date of the schedule that was imported during a specific period

End Date Variance - This is the difference between the end date of the current schedule and the baseline (cumulative)
and the previous schedule update (period).

Critical Path Delay - This is the total historical critical path DELAY that has accumulated on a project (cumulative) or during
a specific window (period) of time.

Realized Critical Path Recovery - This is the total historical critical path Recovery that has accumulated on a project
(cumulative) or during a specific window (period) of time.

Net Critical Path Delay - This is the net historical critical path delay that has accumulated on a project (cumulative) or
during a specific window (period) of time MINUS historical critical path Recovery (both cumulative and in each period.) This
explains how much the project has been impacted and factors in how much realized recovery has existed to minimize delay
exposure.

SmartPM’



« Description of Critical Path Delays/Recovery - this identifies the activities that were critically delayed or recovered
during a specific period.

- Planned Delay Recovery - This is the amount of critical path recovery that has been built in to the go-forward
schedule (so, unrealized recovery) to reduce historical delay exposure.

« Schedule Compression Index - This is a gauge that indicates whether a schedule has been modified to complete
more collective work in equal or less amount of time as compared to the baseline. Generally speaking, a number
greater than 1 indicates compression, less than 1 equals decompression and 1 is equal to the same level as the
baseline. To explain in Lehman’s terms; if the schedule compression index is equal to 2, then that means the schedule
is now set up to do twice the amount of work in the remaining time frame than it was originally to do (thus geared to
minimize delay, albeit at risk).

SmartPM’



Audit Log

In an effort to better understand the S G—— GrE—— () G—

various modifications made from one Copy Schodle
schedule update, we keep a running log N COMOALOMIGES | MK CHTCALCHNGES | ACTHTY CHAGES | LOGCHAGES | DUNTONCHMGSS | S T s o
on changes and dates for these changes. e | w : - . " ‘ i
Our product then runs through these .| . 4 = . . : b
changes and lets the user know which = - — - v : =

changes had a direct impact on the go- meoste : v 1: : : s

forward critical and near critical paths.
Click on any figure to drill down to see et o 5 5 o 5 :
what specific changes were made. = = = e T . —

o, .
Note: Changes to the Critical Path and DURATION CHANGES ON 2018-09-24
N i i Wi V Select All | Deselect All
ear Critical Path will have a red and
DATE 1D CHANGE ITEM OLD VALUE NEW VALUE USER ACCEPTED
. . 2018-09-24 w | ENV:8030 (Entry Lobbies - North & South) | Activity 200 10.0 Billy @
orange box, respectively, in the far left
2018-09-24 v | 1B.10.1090 (HVAC Fiex Duct) Activity 7.0 30 Billy @
(planned_duration) Upchurch
C O | U m n 2018-09-24 v | ©C1320 (Fine Grade Service Drive) Activity 200 5.0 Billy @
I (planned_duration) Upchurch
2018-09-24 v | ©5.0230 (Re-Mobilize Pre-Cast Crew) Activity 10 20 Billy e
I (planned_duration) Upchurch
2018-09-24 v | (CS5.0230 (Re-Mobilize Pre-Cast Crew) Activity 2018-10-08 Billy v
I (constrainedDate) Upchurch
2018-09-24 v | (GS.0220 (Grade Subgrade @ Crane Activity 50 40 Billy &
I Pathway) (planned_duration) Upchurch
2018-09-24 v | (G5.1356 (Form / Re-Bar / MEP / Place - Activity 19.0 17.0 Billy n
Level 35b) (planned_duration) Upchurch
2018-09-24 v | ©S.1352 (Form / Re-Bar / MEP / Place - Activity 15.0 13.0 Billy @
Level 35a) (planned_duration) Upchurch
2018-09-24 v | €S.1296 (Form / Re-Bar / MEP / Place - Activity 50 40 Billy 7
I Level 29b) (planned_duration) Upchurch
2018-09-24 v | ©5.1282 (Form / Re-Bar / MEP / Place - Activity 6.0 50 Billy @
Level 23a) (planned_duration) Upchurch
2018-09-24 v | €5.1262 (Form / Re-Bar/ MEP / Place - Activity 6.0 50 Billy @
I Level 26a) (planned_duration) Upchurch
2018-09-24 v | ©5.1302 (Form / Re-Bar/ MEP / Place - Activity 6.0 50 Billy e
Level 30a) (planned_duration) Upchurch
2018-09-24 v CS.0060 (M/E/P Underground (B1 Upper Activity 3.0 50 Billy ) ™
I Ramp)) (planned_duration) Upchurch S m a r't P M




The Tools menu located on the top ribbon of the Gantt Chart view, allows
you to quickly maintain your available projects. The Tools menu provides
the following options:

Toaols Project Sefup =

Create Mew Project 0

1. Create a new Project by importing new Schedule Files. Complete the
fields in the pop up window and Click “Submit” Load Existing Project @)
2. Open an already existing Active Project. You will have quick access to Refresh Active Project 9

any Project without having to navigate to the dashboard

3. Re-load the currently opened Project Load Archived Project 9
4. Open a Project that has been Archived
5. Open the Print menu to choose from Print to PDF options (more on p. 2) ' P“”te
6. Toggles the opened Project between Active and Archived. When “Active,”
the Project is available to Company Users for normal use. When PEERSESIESG 6
“Archived,” the Project is removed from the Company’s dashboard and is Delete @)

stored in a safe place until it is resurrected

7. This completely removes every aspect of the opened Project from the Import Microsoft Project (MPF)

Company. Deleting a Project is irreversible and Project will never be Export Excel Data

accessible again.

SmartPM’



The Print allows you to generate a PDF Document that shows the current
status of the Project Gantt Chart. You can choose from a Full or Summary -
Re Ort. Create New Project
p . . . . . . Load Existing Project
1. Full Report prints the Project as it is shown on the screen. It will print
based on any Filters, Organization, or Sorting that is currently active.
Additionally, the Full Report menu has 3 Calendar time-scale options:
» Full Schedule - The time scale of the Calendar will span from the
Original Start Date to the Current Finish Date listed in the
Schedule Spreadsheet in the Project Metrics' General Tab
» 3-Week Look Ahead - The time scale of the Calendar will span

Tools » Project Sefup =

Refresh Active Project

Load Archived Project

ArchiveilRestore

Delete

from 3 Weeks before the Data Date to 3 Weeks after the Data Wi i A
Da te ?:-:p-ort Exocel D"ata
» 6-Week Look Ahead - The time scale of the Calendar will span
from 6 Weeks before the Data Date to 6 Weeks after the Data PRINT SCHEDULE
Date
0 c . . . ® Full Schedule
2. Summary Report prints the Project in a summarized view based on the ) 3.Week Look Ahead
Project’s WBS Structure. It will print summary bars based on a selected O 6-Week Look Ahead

range of WBS levels which will highlight Historical Critical Path, Historical
Near Critical Path, Critical Path Delay, Critical Path Recovery. The Summary
Schedule menu requires the following Menu choices:

Paper Sizes

: 0 Legal (8.5x14)
« Select Schedule Update: Select from which schedule update the ) Tabloid (11x17)
graphic will be based off of O ArchD (24x36)

« Select Paper Size: Select the dimensions of the generated PDF ) ArehE (3648)

« Select WBS Level to Group From/To: Select the range of WBS
Levels the summary bars will be generated via. Note, the
maximum selectable range is 2 levels apart

Cancel

Y INDEX

Full Report

Summary Report

7 Juni2 17
Apr 29, 19
9 Mar1, 19

6 Aug 21,16

PRINT SUMMARY REPORT

Select Schedule Update:

December 19, 2018

Select Paper Size:

Legal

Select WBS Level to Group From:

Level 3

Select WBS Level to Group To:

Level 5

[P G secion
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The Project Setup menu located on the top ribbon of the Gantt Chart
view, allows you to quickly maintain the currently opened project. The
Project Setup menu provides the following options:

1. Add Users in order for them to access to the opened project

2. Review and edit all Activity Calendars

3. Review and edit all Activity Codes

4, Review and edit the WBS Structure

5. Review, add, edit, and activate Project Filters

6. Review, add, edit, and activate the Project’s Sorting and
Organizational Structure

7. Modify the Project’'s Name, Location, and Features

Project Setup =

Uzers o
Calendars 9

Activity Codes 9
Labor

Equipment

WES Codes Q

Custom Data Fields

Filters 9

Crganization e

Settings 0
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1. Once you have created a Project, you will need to decide which Users from
your Company's Roster will have access to the Project. You will also define
the User Role each User will have in interacting with the Project.

Click Submit.

1. There are 4 different User Roles:

« Schedule Administrator: The Schedule Administrator Role allows users
access to all aspects of the SmartPM™ platform including project set
up, schedule management, and field entry/modification.

- Project Manager: Project Managers have the ability to enter data into
the program through the field update log for any activity in the
schedule. They do not have the ability to modify the project setup or
schedule in any way.

- Activity Manager: Activity Managers have the ability to enter data into
the program through the field update log for only the activities for
which they are listed as the "Activity Manager". They do not have the
ability to modify the project setup or schedule in any way and they
don't have the ability to enter data on activities for which they aren't
listed as the "Activity Manager".

« Read-Only: A Read-Only User will have no ability to alter the state of
the Project in anyway, however can utilize the program for project
review and analysis purposes.

2. You can remove a User from the Project by clicking the Red Trash Can button

Billy Upchurch

BILLY UPCHURCH i

FIRSTNAME | Billy

LAST NAME Upchurch

E-MAIL bupchurch86@gmail.com
PHONE

ROLE

Schedule Admin

FIRSTNAME | Billy

LAST NAME Upchurch

E-MAIL bupchurch86@gmail.com
PHONE

ROLE Schedule Admin
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Every Activity must be assigned a Calendar. The Calendar assigned will be used in the

calculation of the Activity’s Current & Planned Start & Finish Dates by using the CALENDAR

Calendar's defined Work Days and Work Hours. Every new Project will include a all
Calendars from all imported Schedules. You can view, edit, add, and delete Calendars e s :
from this menu. r-0av (no Hotava)

1. To add a calendar:
« Click the Green Plus button
Select the newly created Calendar
Click the Blue Wrench button
Click the Blue Pencil button to edit the following Calendar information
% Title - You will need to type the Calendar's title into the text field
» The new Calendar’s default title will be “New Menu ‘#”
% Standard Daily Work Hours - You will need to enter in the how many
hours make up a work day for each day of the week
» The program will default to a five day, eight hours a day schedule CALENDAR
% Holidays: You can select what days of the year will be considered
non-working holidays. You can toggle a holiday by double-clicking on a 5 sy woriosk NG Holdars -
specific date within the shown 12-month calendar. All Holidays are T
denoted by grey boxes. ‘
» Newly created Calendars are defaulted to include standard US
Holidays
To save changes, click the Blue Check Mark
The new Calendar can be assigned to Activities in the Activity Metrics tab

Standard Work Week for: "7 - Day Workweek (No Holidays)"

2. You can edit already existing Calendars by selecting the Calendar you want to edit,
clicking the blue wrench, click the blue pencil, and following the same steps as
adding a new Calendar

3. You can delete already existing Calendars by selecting the Calendar you want to
delete, clicking the blue wrench, and clicking the red trash can SmartPM’




Activity Codes are values that identify characteristics of the work or in some ACTIVITY CODES

way categorize schedule Activities that allow for filtering and ordering of
Activities within reports. Activity Codes are structured by using Activity Code

Parents and Activity Code Children, where the Children are subsets of the
Parents. Every new Project will include all Activity Codes from all imported
Schedules. You can view, edit, add, and delete Activity Codes from this menu.

1. To add an Activity Code Parent:

» Click the Green Plus button in the Parent window

» Select the newly created Activity Code

» Click the Blue Wrench button

« Click the Blue Pencil button and give the Activity Code Parent a name
« To save changes, click the Blue Check Mark

2. To add an Activity Code child:

« Select the Activity Code Parent you want to add the Activity Code
Child under

« Click the Green Plus button in the Child window

« Select the newly created Activity Code

« Click the Blue Wrench button

« Click the Blue Pencil button and give the Activity Code Parent a name

« To save changes, click the Blue Check Mark

- The new Activity Code Child can be assigned to Activities in the
Activity Metrics tab

Sandpoint Services

Concrete Sub

|
| Masonry Sub
|

Flooring Sub
Gutters & Downspouts Sub
Miscellaneous Steel Sub
| General Sitework
| Demolition Sub
|

Hazardous Material Abatement

Cadre Wing -
Core Areas

Main Electrical Room

Main Mechanical Room

Core Area Classrooms

Sitework

Project-Wide Testing & Closeol
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3. Re-Order Activity Code Child

« Select the Activity Code Parent of the Activity Code Children to be

re-ordered

« Select the Activity Code Child to be re-ordered

« Click the Blue Wrench button ACTIVITY CODES

« Click either the Blue Up or Yellow Down Arrow buttons until the I e
Activity Code Child is in the correct place

« The order of the Activity Code Children within this window will be —— B E.
the order in which they will be Organized and Sorted within the Design Package

Design Package 3

Gantt Chart when the Organize function is being utilized

Design Package 4
Planning & Permits

Submittals & Submttals Review

4. You can edit already existing Activity Codes by selecting the Code you Fabrication & Delivery
want to edit, clicking the '
blue wrench, click the blue pencil, and following the same steps as
adding a new Activity Code

5. You can delete already existing Activity Codes by selecting the Activity
Code you want to delete, clicking the blue wrench, and clicking the red
trash can

SmartPM’



A WBS Structure is a way to organize Activities within a Schedule. Each
Schedule’s WBS Structure is comprised of WBS Codes which are then
assigned to Levels on a hierarchy. Every new Project will reflect the WBS
Structure from the most recent Schedule import. You can view, edit, add
to, and delete from the WBS Structure from this menu.

e To add a WBS Code:

> Select the WBS Code you would like the new code to go directly
under

> Click the Green Plus button in the Parent window
» Enter the Code and Code Name in the right window

» Use the left and right arrow buttons to place the new WBS Code
in the correct hierarchy

* You can edit already existing WBS Codes by selecting the Code you
want to edit and following the same steps as adding a new WBS Code

* You can delete already existing WBS Codes by selecting the WBS
Code you want to delete and clicking the Grey “X" button

WBS CODES

WBS Code
SMARTPM APARTMENTS
Contract Milestones
Construction Milestones
Schedule Impacts
Shear Wall
Bﬁes'ai 'L,(-: hanges
Door Hardware Revisions
Amenity Level Design
Pool Deck Re-Design

Drains Design Finalization @

Eg\?url-a:ﬁ?gge Inspections
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The Filter functionality allows you to determine which Activities will be shown in the

Gantt Chart based on selected Activity Attributes. SmartPM™ comes with numerous FILTER
useful Filters built in and also allows you to create custom Filters. To set a Filter, you None
need to have the Filter Toggle Switch to turn “On” and then navigate to the Filter Critical Path
menu. Near Critical

Non Critical

To activate a pre-loaded filter, simply select the filter and click “Apply” F

To create a New Filter: s
1. Click the blue Create New button ot Started
2. Enter the Filter's name in the “Name” field e —_—
3. Click the “And/Or” drop down menu and select “And” or “Or” Complete Critical Path
» “And"” Filters - Activities must fit all defined parameters in order to be High Float
displayed in the Gantt Chart tieh Burafien
> “Or” Filters - Activities must fit at least one of the defined . '
parameters to be displayed in the Gantt Chart
4. Click the Green Plus button to add a parameter
Click the drop-down menu in the Parameter column and select which
Attribute this Parameter will be based on N
6. Click the drop-down in the "Is" column and select the desired type of M =
status of the Attribute(s)
In the Value column, enter or select the status of the Attribute(s) desired
8. Ifthe type of status is a range, enter or select the top of the range in the
High Value Column
» To delete a Parameter, select the Parameter to be deleted and click
the Red Trashcan Button
9. Once all Parameters are entered, click “Save & Close”

Incomplete Milestones

e

FILTER

~
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« The Organizational Structure menu allows you to organize your Activities by
the assigned WBS Structure or Activity Code for easier viewing & navigation

ORGANIZATIONAL STRUCTURE

:
of the Project. —  pET——— =

- To organize by the WBS Structure, simply click the “Group by WBS" check
box and click “Submit”

- To organize by Activity Code:

» In the “Grouping Structure” window to Add by clicking the green “+”
button. In the drop down window choose the appropriate Code and () Group by W8S
repeat as necessary

> After the Grouping Structure is set, set the “Sorting Structure” in the

right window of the window by CliCkiﬂg the green “+" putton. In the drop ORGANIZATIONAL STRUCTURE
down window choose the appropriate Sort parameter and repeat as

necessary
» Click Submit
- To view the Organizational Structure, you need to have the
Organization Toggle Switch to turn “On.”

# Group by WBS m Close
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